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Programator AVRISP mkII posiada domysInie wsad
obstugiwany przez srodowisko BASCOM i AVR DUDE. JeSli
programator ma wspolpracowac ze srodowiskiem AVR Studio,
nalezy zaktualizowac¢ jego wsad zgodnie z instrukcja
zamieszczona w rozdziale 3: Aktualizacja wsadu procesora.
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1. Programowanie w Srodowisku BASCOM i AVR DUDE

a) Instalacja sterownikow

UWAGA!!
przed pierwszym podlaczeniem programatora do komputera, nalezy najpierw
zainstalowac sterowniki AVRJungoUSB.

link: http://www.and-tech.pl/MKII/AVRJungoUSB.exe

Do potaczenia programatora z komputerem wykorzystywany jest przewod mini USB
(popularny w telefonach komoérkowych i aparatach). Zalecane jest korzystanie z przewodu o
dlugos$ci 1.8m lub mniejsze;j.

Potaczenie z uktadem programowanym zapewnia tasma zakonczona z obu stron wtykami
IDC-10. Rozktad pinéw umieszczony jest na programatorze.

Po podtaczeniu programatora, system powinien sam wykry¢ i zainstalowa¢ odpowiednie
sterowniki. Jesli zainstalowat si¢ poprawnie, w Menadzerze urzgdzen powinno znalez¢ si¢
urzadzenie Jungo z dwiema zaktadkami: AVRISP mkII oraz WinDriver.. Menadzer urzadzen
dostepny jest w Panel sterowania > System >zaktadka Sprzet.

[+ Klawiatury

# i Komputer

+- 8, Kontrolery dawieky, wideo i gier
+-6=%) Kaontralery IDE ATAFATAPT

- % Kontrolery stacii dvskigtek

+

I+

Kontrolery uniwersalnej magistrali szeregowe]
& Monitary

14|+

# ) Mysziinne urzadzenia wskazujace
+- % Porty (COMiLPT)

¥ Procesory

M stacie dyskietek

g Stacie dyskdw

Lk Stacje dyskiw CO-ROMIDYD

=48 Urzgdzenia do obrazowania

[ [ ][] ][

1+

llustracja 1

UWAGA!!

W przypadku, gdy programator zostal pomyslnie zainstalowany przez system
operacyjny (Windows), Swieci si¢ na zielono dioda. Jesli tak nie jest, prosze
podlaczy¢ go bezposrednio do PC lub laptopa z pominieciem HUBGw i stacji
dokujacej. W niektorych sytuacjach, urzadzenia te uniemozliwiaja poprawna prace
programatora.
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Nastepnie nalezy pobra¢ aplikacj¢ LibUsbDotNet_Setup.2.2.8
link: http:/www.and-tech.pl/MKII/LibUsbDotNet_Setup.2.2.8.exe

Po akceptacji licencji oraz wybraniu $ciezki instalacji, powinni$my zobaczy¢ okno, przedstawione
na [lustracji 2. Wybieramy wylacznie pierwsza pozycje — Runtime Files 1 klikamy Next.

i) Setup - LibUsbDotNet

Select Components
Which components should be installed?

Select the components vou want toinstall; clear the components vou do not wank ko
install, Click Mexk when wou are ready ko continue,

I Lstom Installation

T@} Runtime Files
[] source and Example Code

Current selection requires ak least 5,0 ME of disk space.

[ < Back. ” Mexk = ][ Cancel J

llustracja 2

Zaznaczamy Install libusb-win32 with filter capabilitied? podobnie jak na Ilustracji 3 1 klikamy
Next.

fie Setup - LibUsbDotNet

Select Additional Tasks ~
Which additional tasks should be performed?

Select the additional Fasks wou waould like Setup o perfarm while inskalling
LibUsbDakret, then click Mext,

libush-windz,

Install libusb-win3z with filker cap@

« Back ”_ Next}}__J [ Zancel
by

llustracja 3
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f! Setup - LibUsbDotNet

Completing the LibUsbDotMNet
Setup Wizard

Setup has finished installing LiblJsbDotMet on your compuker.,
The application may be launched by selecting the installed
icons.,

Click. Finish ko exit Setup,

Launch filter installer wizard

llustracja 4

Uruchamiamy program Filter Wizard. Jest dostepny pod §ciezka: Start->Programy->LibUsbDotNet-
>1ibUsb-win32->Filter Wizard.

RCE

@’ Ckresl dostep do programdw iich ustawienia domyslne
.
'@-_E) Windows Catalog

Wwindows Update

Pragrarmy @ et

@ Zebra Technologies
Dokurmnenty | @& Internet Explorer
[t Paint.NET
@ Mozilla Firefox
Wyszukaj @ FAip3.4.3

@ Hypersnap 6
Pamoc i obstuga techniczna m R

Lstawienia

faf LibUsbOotet i @ classFier v
7 MCS Electronics v & LibUsbDathet Help .

“ Test Device Mokify E; Inf-Wizard

ﬂ Test Info

5 Uninstall LiblsbDothet

73 USE Infwizard

Uruchan. ..

Wylogui: RAFAL...

©
| =
=
Yy
oWy
]
e
o
[
a.
o
o -
W
=
[=}
=
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llustracja 5
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W oknie Install/Remove Device Filter(s) wybieramy pierwsza pozycje Install a device filter-
[lustracja 6.

Information

This program adds/removes libusb-win32 as a driver to an existing device
installation.

The libusb-win3Z filker driver allows access ko ush devices using the libusb-win3z api
while maintaining compatibilicy with software which uses the original driver.

InstalliRemoye Device Filkeris)

(%) Install a device Filker

() Remove a device filker

) Remove all device filkers

[ Mext = l [ Cancel

s

llustracja 6

W kolejnym oknie nalezy zaznaczy¢ urzadzenie AVRISP mklIl, podobnie jak na Ilustracji 7.

Device Seleckion

Caonneck your device and select it From the list af unfilkered devices below, IF wour
device isn't lisked, it may already be filkered, be in a "driverless" skate, or
incompatible with the libusb-win32 Filker driver.

Hardware ID Descripkion |
wid:203a pid:FFfc res: 0100 mi:01 IUrzgdzenie IJSE interfejsu HID (5l
wid:203a pid:FFfc res: 0100 mi; 00 IUrzgdzenie IJSE interfejsu HID (5|
widi203a pid:Fifc res:0100 IUrzgqdzenie kompozytowe USE =

widi203a pid:FFFb rew:0100 IUrzgqdzenie USE interfejsu HID (5

wid:03eh pid: 2104 rev:0200 BWRISP mkIT

3

llustracja 7

Po naci$nigciu przycisku Install powinnisSmy zobaczy¢ nastepujace okno:

\"-!l‘) libusb-win3z device filter successfully installed For AYRISP mkII (usbivid_03ebfpid 210<48rew 02000

.

llustracja 8
Programator zostal poprawnie zainstalowany.

Instrukcja obstugi programatora AVR Prog MKII
www.and-tech.pl



http://www.and-tech.pl/
http://www.and-tech.pl/
http://www.and-tech.pl/

b) Konfiguracja:
1. BASCOM

UWAGA!!

AVR Prog MKII jest wspierany przez BASCOM w wersji 2.0 i wyzszych. W przypadku
nizszych wersji nalezy skorzystaé z zewnetrznego programu, np. AVRDUDE.

Aby programator wspdipracowat ze srodowiskiem BASCOM, nalezy go odpowiednio
skonfigurowa¢. W tym celu, uruchamiamy program BASCOM i przechodzimy do ustawien
programatora — zaktadka Options >Programmer. Z wysuwanej listy Programmer wybieramy
pozycje USBprog Programmer / AVRISP mklI (Ilustracja 9).

BASCOM-AVR Options

| Compiler | Communication | Enveon Frogramsnet | Monitar | Prter
Prograsnmes |USBprag Programmer / AVR ISP mdl :
Play sound '
] Erase weaning hanaFlask [ sulehieiiy [CJugload Code and Dats
[ Program atter compile [ 1 Sat tocus bo berminal emulaion after programming
v
OO - pat | com1 o ] Do rat 2ut 15P clock hequency
Clack 125000 w| [l &vRISP motacal
Tmeuuse 0 (g [Juse
Tneout Sesial 100 @
{ Programmer Cpbiang | =
o] [

llustracja 9

Nastepnie zaznaczamy opcje¢ USB 1 klikamy OK.

Instrukcja obstugi programatora AVR Prog MKII
www.and-tech.pl



http://www.and-tech.pl/
http://www.and-tech.pl/
http://www.and-tech.pl/

BASCOM-AVR Options
| Enc!1|_:;ibr i Ecmnmc.ﬂmn Eml_i:urn?ndi S_irr't.i:a_!l:t_: Programmer H_uri!l:-r_' Plirﬁm_f )

Frogtatrenet USBprop Fropramme: / VR ISP el v
Flay sournd I
[ 1Emase warrmg [l Aute Flash Aulcietily [] Uplead Code and Data
[ Pragram after compile [ 52t focus to termingt emulator after pragiamming
“Abmel

COM-part oMt w  L]Donotset1SP clack hequency

Clock 1135000 w [ AVRISE protossl

Timeout USE |100 *
Timzout Serial 100 @

v o ][] s

llustracja 10

Programowanie uktadu odbywa si¢ po kliknigciu w ikong Program chip.

IR BASCOM-AVR IDE [2.0.7.1] - [C:\Documents and Settings\0peratoriPulpit PRAKTYKIWURS Y \RARYwo dy_ 2Ykod 3. bas]

‘Fi Fle Ede Miew Progam  Tooks  Options  Window  Help
1'H q-ﬂ"-'.l-:-r:' IEI'____) -'.-;...-:' 3%%@@5'-!-'1?-\? ?-:

| kodzbas |23

Sub = Label X
‘Sregfile = "nbd4pdef dat” "dla procesora ATHegacidp
"Sregiile = "n32def  dat” ‘dla procssora ATHegal2
Sregfile =« "nl6def dat” ‘dla procesors ATHegaln

Scrystal = 16000000

Do

'‘poczatek patli
Set FORTE 0
'gaziny dicdg
‘dicda w naszgym zestavie zadwvieca =ie po podaniu na jej wyprovadzenie stanu niskisgo
Uait 1 ‘czekamy 1=

- l: - . -
Mlustracja 11

Okno programowania przedstawia Ilustracja 12.
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Elektor f mkll compatible Programmer

File Buffer Chip

PrHE e TT W E.

Chip

7

Flazh size 0 KB

EPROM | Lock and Fuse bits
00| |02 |02|o04]os |08 |07 | o8]

EEPROM size 0 Bytes

[ED
1095
FES
EES
40 |95
5055
&0 ]eF
70 |BF
a0 e0
E
4034
BO|F7
co]ss
pa|Fo
E0|q

Zaktadki Flash, EEPROM i Lock and Fuse bits umozliwiaja podglad kolejno pamigci FLASH,

0c 0o
18 00 00
158 00 00
158 00 00
18 00 00
158 00 00
SE E0 D4
a4 E1 88
B0 27 &3
FO 54 0OE
OC 00 46
D3 95 03
ES F8 B2

95
95
95
95
ES
E0
27
93
oo
94
97
95

13
13
13
13
aF
F4
93
aD
54
Fa
Kl
03

31 EAEDEOQFF

EF 55 03

an
an
an
an

o0 95 13
a0 95 13
a0 95 13
o0 95 13

BF 80 E3C8

2E

5F 95 A8

BD 81 BD 51

a7
a3

31 F7 E3
CO EDE1

CF FF EE 83

F7
a3
a7

F1 95 03
EF 93 FF
3 F7F

09 04|08 |oc|oo| e | oF |
24,95 18 00/00 9518 00 00 95 18 00|00 .~

00 0095 18 00
00 009518 00
00 009518 00
00 0095 18 00
E2 EO 2E 4E ED
B7 B4 2E 03 7F

oo =
oo =
oo =
oo = e

84 |+ [2:T SCE7NF,
87 &flfe._+" ..k

EF EE EDF3 EB AD 2 &™ 1 dirac

24 BE 94 COED
EO FO 34 0E 00
E0 93 DOOC 97
34 B8 F3 B2 95
27 EE 2B E8 2B
97 0 F7 D13

E1 1 T-1+£4HRF8

54 fd". TIRfafd". T

A LFDre -1

08 +Lle =1 +hie “hibe.

EQ “tfbe"d™ 'T+i+e

FF dleff =1+ <H"
.

o C:\Docurnents and SettingstOperatarsPulpits PRAKTYRISKURSY S AARYkady_ 28 OD3.EEP not found.
o C:A\Documentz and SettingshOperatoryPulpity  PRAETYEIMKURSYSRARkody_24K 0D 3 BIM loaded 228 bytes into FLASH buffer
o Elektar / mkll compatible programmer set

0 Started
llustracja 12

EEPROM i fuse bitow procesora po zaprogramowaniu.

Przycisk:
& - pozwala na identyfikacje procesora,
- - sprawdza, czy pamig¢ procesora jest ,,czysta”
b | - kasuje pamie¢ procesora i programuje go

2. AVR DUDE

W celu korzystania ze srodowiska AVRDUDE nalezy pobra¢ avrdude-5.8-w32_avrdude-

GUI _1.0.5
link: http://www.and-tech.pl/MKII/avrdude-5.8.zip

Po wypakowaniu wiaczamy graficzny interfejs: avrdude-GUI exe 1 nastgpnie w oknie
Programmer wybieramy Atmel AVR ISP mkll (avrispmkll), w oknie Port — usbh, w oknie
Device — model procesora, ktory chcemy zaprogramowac. Podobnie jak na ilustracji 13.

Przycisk Read stuzy do odczytu, Write — do zapisu, Verify — do weryfikacji pamigci
procesora. Guzik Erase — Write — Verify kolejno czysci, zapisuje i weryfikuje pamigé

procesora.

Instrukcja obstugi programatora AVR Prog MKII
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t® avrdude-GUI [yuki-lab. jp Version 1.0.5]

avtdude. exe File

|avrdude.exe

Frogramrmer

[ Display Window

Atmel AWE ISP mkll (avrispmkll)

Device Command line Option

ATmegalb (m16) |

Fuse Flash
hFuse I:I h [ mead | | H ]
IFuse | | h | Read | | Write |
eFuse I:I h [ Whte | | “erify | | Erase - Write - Verify |
Lock Bit EEFROM
Read | | [ ]
I—I h WWrite | Read | | Write |
| Chip Erase | | Terminal | | Exit |

O

llustracja 13

Instrukcja obstugi programatora AVR Prog MKII
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2. Programowanie w Srodowisku AVR Studio
a) Instalacja sterownikow

UWAGA!!
przed pierwszym podlaczeniem programatora do komputera, nalezy najpierw
zainstalowac sterowniki AVRJungoUSB.

link: http://www.and-tech.pl/MKII/AVRJungoUSB.exe

Do podtaczenia programatora z komputerem wykorzystywany jest przewdd mini USB
(popularny w telefonach komoérkowych i aparatach). Zalecane jest korzystanie z przewodu o
dlugos$ci 1.8m lub mniejsze;j.

Potaczenie z uktadem programowanym zapewnia tasma zakonczona z obu stron wtykami
IDC-10. Rozktad pinéw umieszczony jest na programatorze.

Po podtaczeniu programatora, system powinien sam znalez¢ 1 zainstalowa¢ odpowiednie
sterowniki. Jesli zainstalowat si¢ poprawnie, w Menadzerze urzgdzen powinno znalez¢ si¢
urzadzenie Jungo z dwiema zaktadkami: AVRISP mkll oraz WinDriver. Menadzer urzadzen
dostepny jest w Panel sterowania > System >zaktadka Sprzet.

=3 raF

e Klawiatury

+ rj Kompuker

=B, Konkrolery diwisku, wideno i gier
=4 Kontrolery IDE ATAMATAPT

% Kontrolery stacji dvskietelk,

Kontrolery uniwersalnej magistrali szeregowej

_'; Manitary

- MJ' Mwsz i inne urzgdzenia wskazujgce
|- Party (COM i LPT)

ﬂ Procesaory

_& Stacje dvskiekek

“ge Stacje dyskow

s Stacje dyskdw CD-ROMJDVD

=48 Urzgdzenia do obrazowania

e o e e e e T B

e o e o A B B T |

llustracja 14

UWAGA!!

W przypadku, gdy programator zostal pomyslnie zainstalowany przez system
operacyjny (Windows), Swieci si¢ na zielono dioda. Jesli tak nie jest, prosze
podlaczy¢ go bezposrednio do PC lub laptopa z pomini¢ciem HUBOw i stacji
dokujacej. W niektorych sytuacjach, urzadzenia te uniemozliwiaja poprawna prace
programatora.

Instrukcja obstugi programatora AVR Prog MKII
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b) Konfiguracja

W celu konfiguracji nalezy wlaczy¢ program AVR Studio. Opcje programatora sg dostepne w
zaktadce Tools->AVR Programming. (Ilustracja 15).

AVR Studio

File Edit  Wiew Wassist¥  Project Cebug  Tools  window  Help

ey e e B = R e - -Jl=ie
BE R E W 0 - g W rogenmin e Tl E- i

Add STESOTS

AvR OTauch Studia
Code Snippets Manager... Chrl+k, Chrl+B

Add-in Manager. ..

Extension Manager. ..
External Tools., ..

Impart and Export Settings. ..

Custamize. .,

Options...

llustracja 15

Z rozwijanej listy Tool nalezy wybra¢ programator AVRISP mkll. W zaktadce Device okresla si¢
model procesora, ktory chcemy programowac a nastgpnie przyciskiem Apply zapisuje si¢
ustawienia.

AVYR Programming

Device Interface Device [0 Target Yoltage

ATmegalé * |I5P v| [.fl.pph.f ] |nnt read El

llustracja 16

Instrukcja obstugi programatora AVR Prog MKII
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Przycisk Read odczytuje numer procesora i napigcie programowanego obwodu.

AVRISP mkll (0D00OAQO128255) - AVR Programming

Toal Device Interface Device 10 Target Yolkage

ATmegals (DAE0x34 0303 ||Read | | 5,0% |[Read |

Intetface settings ISP Clack

Tool infarmation ! '

Device information
The ISP Clock frequency must be lower than 1/4 of frequency the device is operating on.
Memaries

Fuses

Lock bits

llustracja 17

W zaktadce Memories programuje si¢ pami¢¢ procesora.

AVRISP mkll (00D0ADOT 28255) - AVR Programming

Tool Device Interface Device [D Target Yoltage
AVRISP mKIT ~ | ATmegals - I v (OxIE0x940x03  ||Read | | 50% [Read|

Inkerface sethings Device

Tool information

Dievice informnation [#]werify device after programming
< Memaries ) Flazh
Wi | v -]
Lock bits
Erase device before programming Read...
EEPROM

llustracja 18

Instrukcja obstugi programatora AVR Prog MKII
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3. Aktualizacja wsadu programatora

Programator AVRISP mkll posiada domyslnie wsad obstugiwany przez srodowisko
BASCOM i AVR DUDE. Jesli korzystasz z tych programdéw, pomin ten rozdzial. Jesli
programator ma wspotpracowac ze srodowiskiem AVR Studio, nalezy zaktualizowac jego
wsad zgodnie z ponizszg instrukcja.

Aby zaktualizowac programator potrzebny jest program FLIP:
link: http://www.and-tech.pl/MKII/FlipInstaller-3.4.5.106.exe

oraz nowy wsad:

101116 _AVRISP studio.hex
link: http:/www.and-tech.pl/MKII/101116_AVRISP_studio.zip

Postepuj zgodnie z tg instrukcjg w celu wystania nowego oprogramowania do programatora
przy pomocy FLIPa.

Zainstaluj program FLIP, a nastepnie naci$nij guzik BOOTLOADERA, znajdujacy si¢ na
programatorze, w celu wprowadzenia AVRPROG MKII w tryb bootloadera — sygnalizowany

zgasnigciem zielonej diody.

System wykryje nowy sprzet:

Kreator znajdowania nowego sprzetu

Ten kreator pomaga zainstalowad oprogramowanie dla:

ATI0U5E162 DFU

i‘j Jesli do sprzetu dokaczony byl instalacyiny
2 dpzk CD lub dyskietka, whéz ten nognik teraz.

Co chcesz, aby zrobik kreator?

() Zainstaluj oprogramowanie automatyczhie [zalecans]

{(®1i2ainstaly) z listy lub okreslone| lok alizac) [zaawansowane}

Flikmij pravcizk Dale), aby kontpnuowad.

< wiztecz ” Dalej » ][ Anuluj

Hlustracja 19

Instrukcja obstugi programatora AVR Prog MKII
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Nalezy wybra¢ opcj¢ Zainstaluj z listy okreslonej lokalizacji (zaawansowane) 1 podac
lokalizacje przedstawiong na Ilustracji 20 - Program Files / Atmel / Flip 3.4.3 / usb.

Przegladanie w poszukiwaniu folderu |E| E'

Wwbierz Folder, kkary zawiera sterowniki dla sprzetu,

[=) S sk lokalmy (200
=) dell
|5 Documents and Settings
[ drvrkmp
= IC3) Program Files
I Adobe
I Analog Devices
=155 akmel
I AYR"Jungo USE
|5 FLIP 2.4.6
= IC5) Flip 3.4.3
I bin
I demo
I help
I3 inFo
Sl
I amdes
I iass
|5 Updatelriver

I =86

_— .

[

[ %

Bbey wyswietlic podfoldery, kliknij poweyzei znak plus,

ok || anuly

llustracja 20

Kliknij OK 1 uruchom program FLIP.
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=[o] x|

File EBuffer Device 3Settings Help

S FSINUS N S

~Operations Flow————— FLA3H Buffer Information——— - ATI0USELEZ

Size. 12KE Signatire Bytes I_I_ I_I_

@ [+ Erase
Frange D=0 - Oxi
£ Device Book Idsl I
hecksum [xER
@ [ Elank Gheck
Reset Before Loading LOBUEEC e I
@ [ Frogram HEX File:

@ [ verfy El
RN ERSRRE R
Fum Seleck EERRON | Starh Application | [ Feset

I ICDmmunicatiDn OFF

llustracja 21

Nacisnij ikone Select device (symbol chipa) lub opcje w menu Device — Select i nastgpnie
wybierz urzqdzenie z listy (at90usb162) — Ilustracja 22.

Device Selection I x|
P Select a device
*'r) ATI0USEL 62

ATI0USEG4E

ATI0USEGET

ATI0USESZ

aTmegalell:

aTmegalelld

ATmegas3zUz J
aTmegaszll4

ATmegaszlle

ATmegasLz hd

(] 4 I Cancell

llustracja 22

Teraz kliknij na ikon¢ Select communication (symbol przewodu USB) 1 wybierz USB.

Instrukcja obstugi programatora AVR Prog MKII
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USB Port Connection x|

Flose | Cancel |

llustracja 23
Nacis$nij Open.

=1olx|

File Buffer Dewice Settings Help

PSS v hTH S

~Operations Flow—————— ~FLASH Buffer Information————— ~ATI0USELGZ
Signature Bytes IEE |1 = IEM IEE
Size 12KB
@) | Erase
Range D=0 - 0x0
] Device Book Idsll:ll] II:IIJ
Checksum 0xFF
@) [ Blank Check
Reset Before Loading A II'D'S
@& v Program HEX File:
@ ¥ verify El
R
Fun Select EEPROM | Start Application | [+ Reset
| usE oM
Hlustracja 24

Zataduj pobrany wczesniej nowy wsad hex (101116 AVRISP_studio.hex ) naciskajac ikong
LOAD hex file lub poprzez menu File > LOAD HEX File... Po wybraniu pliku wsadowego,
nacis$nij guzik RUN w dolnym lewym rogu.

Instrukcja obstugi programatora AVR Prog MKII
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GOTOWE! Tw¢j programator zostat zaktualizowany.

o C:% AYR Stuff LUFA'LUFA100209% Projects’ AYRISP-MKIT' AYRISP.hex i = I I:Ilil

File Buffer Device Setktings Help

PSS o hT S @9

FLA&SH Buffer Information——— - AT90USE1AZ

~Opetations Flow

Signature By‘teslﬁa |1E IEM IBZ

Size 12KBE
) IV Erase
Range 0x0 - Ox24F5
Device Boot Ids |EIIJ iEIEI
Checksum Ox1 23609
@ [ Elank Check l_
Reset Before Loading Bootloader Ver. |1.0.5
© I Program HEX File: AYRISP hex

462 kil bytes

) v erify
AIMEL

IF;

RUN Select EEPRCM | Start Application | ¥ Reset
| verify PASS ! USE ON
llustracja 25

Kliknij Start Application aby zrestartowa¢ programator.

UWAGA!!
Jesli chcesz, aby programator ponownie dzialal w sSrodowisku BASCOM i AVR DUDE
postepuj ponownie zgodnie z powyzsza instrukcja, ale wykorzystaj ponizszy wsad:

101116 _AVRISP_avrdude.hex
link: http://www.and-tech.pl/MKII/101116_AVRISP_avrdude.zip

Instrukcja obstugi programatora AVR Prog MKII
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4. Obsluga programatora
a) Ziacze ISP
Programator wyposazony jest w 10 pinowe zlacze ISP w standardzie KANDA. Ponizej
znajduje si¢ opis sygnatéw w zlaczu.

GND
GND
GND
GND
VCC

MISO
SCK
RST
GND
MOSI

b) Zlacze TPIi PDI
Drugie 10 pinowe ztacze ISP przewidziane jest do programowania serii Attiny (zlacze
typu TPI) oraz serii Atxmega (ztacze typu PDI).

GND _ RST_I
N.C. CLK .S
+5V DAT

CLK ©
DAT &

¢) Opis jumperow oraz diod LED
UsSB POWER

BUSSY READY
. BN ()

|
Y

5V

3.3

Instrukcja obstugi programatora AVR Prog MKII
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Funkcje zworek programatora:
USB-POWER - zasilanie programowanego obwodu z programatora

5v — napigcie zasilania obwodu napigciem 5V
3.3v — napigcie zasilania obwodu napigciem 3,3V
Diody:
READY - programator zasilany i gotowy do pracy
BUSSY — programator zajety (programuje)
d) Przycisk bootloadera

Nacis$nigcie powoduje przejscie programatora w tryb bootloadera — sygnalizowanym
zgasnigciem zielonej diody.

Przycisk
bootloadera

llustracja 26
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5. Ochrona srodowiska

Oznakowanie symbolem ,,przekreslonego kontenera na odpady” informuje o zakazie
umieszczania zuzytego sprzetu elektrycznego i elektronicznego tacznie z innymi odpadami,
zuzyty sprzg¢t powinien by¢ zbierany selektywnie. Uzytkownik ma obowigzek przekazaé
zuzyty sprzet do punktu zbierania w celu zapewnienia jego recyklingu i odzysku, gdyz
niekontrolowane uwalnianie do srodowiska sktadnikow niebezpiecznych zawartych w
sprzecie elektrycznym i elektronicznym moze sta¢ si¢ zrodlem zagrozenia dla zdrowia ludzi
1 zwierzat oraz moze powodowac¢ dhugo utrzymujace si¢ negatywne zmiany w srodowisku
naturalnym.
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INFORMACJA
AVRPROG MKII zostal wsparty bibliotekami LUFA, ktore sag wydane na licencji MIT
(http://www.fourwalledcubicle.com/LUFA. .php).
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